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Introduction

Congratulations on your purchase of 
the advanced and compact KU380 
3G video mobile phone, designed to 
operate with the latest digital mobile 
communication technology.

This user’s guide contains 
important information on the 
use and operation of this phone. 
Please read all the information 
carefully for optimal performance 
and to prevent any damage to or 
misuse of the phone. Any changes 
or modifications not expressly 
approved in this user’s guide 
could void your warranty for this 
equipment.

Use of phone cases with magnetic 
locks with slide type phones has 
caused problems such as loss 
of network signal and phones 
powering off. 

Introduction
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For Your Safety

Please read these simple guidelines. 
Not following these guidelines may be 
dangerous or illegal. Further detailed 
information is given in this manual.

WARNING! 
•  Mobile Phones must be switched off at 

all times in aircrafts.
•  Do not hold the phone in your hand 

while driving.
•  Do not use your phone near petrol 

stations, fuel depots, chemical plants 
or blasting operations.

•  For your safety, use ONLY specified 
ORIGINAL batteries and chargers.

•  Do not handle the phone with wet 
hands while it is being charged. It may 
cause an electric shock or seriously 
damage your phone.

•  Keep the phone in a safe place out of 
small children’s reach. It includes small 
parts which, if detached, may cause a 
choking hazard.

CAUTION! 
•  Switch off the phone in any area 

where required by special regulations. 
For example, do not use your phone 
in hospitals or it may affect sensitive 
medical equipment.

•  Emergency calls may not be available 
under all mobile networks. Therefore, 
you should never depend solely on your 
mobile phone for emergency calls.

•  Only use ORIGINAL accessories to 
avoid damage to your phone.

•  All radio transmitters carry risks of 
interference with electronics in close 
proximity. Minor interference may 
affect TVs, radios, PCs, etc.

•  Batteries should be disposed of in 
accordance with relevant legislation.

•  Do not dismantle the phone or 
battery.

For Your Safety
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Guidelines for Safe and Efficient Use

Please read these simple guidelines. 
Not following these guidelines may be 
dangerous or illegal. Further detailed 
information is given in this manual.

Certification 
information (SAR)
THIS DEVICE MEETS 
INTERNATIONAL GUIDELINES 
FOR EXPOSURE TO RADIO 
WAVES

Your mobile device is a radio 
transmitter and receiver. It is designed 
and manufactured not to exceed the 
limits for exposure to radio frequency 
(RF) recommended by international 
guidelines (ICNIRP). These limits are 
part of comprehensive guidelines 
and establish permitted levels of RF 
energy for the general population. 
The guidelines were developed by 
independent scientific organizations 
through periodic and thorough 
evaluation of scientific studies. The 
guidelines include a substantial safety 
margin designed to assure the safety 
of all persons, regardless of age and 
health.

The exposure standard for mobile 
devices employs a unit of measurement 
known as the Specific Absorption 
Rate, or SAR. The SAR limit stated 
in the international guidelines is 2.0 
W/kg*. Tests for SAR are conducted 
using standard operating positions 
with the device transmitting at its 
highest certified power level in all 
tested frequency bands. Although 
the SAR is determined at the highest 
certified power level, the actual SAR 
of the device while operating can be 
well below the maximum value. This 
is because the device is designed to 
operate at multiple power levels so 
as to use only the power required 
to reach the network. In general, the 
closer you are to a base station, the 
lower the power output of the device. 
Before a phone model is available for 
sale to the public, compliance with the 
European R&TTE directive must be 
shown. This directive includes as one 
essential requirement the protection of 
the health and the safety for the user 
and any other person. The highest SAR 
value for this device when tested for 
use at the ear is 0.486 W/kg.

G
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This device meets RF exposure 
guidelines when used either in the 
normal use position against the ear 
or when positioned at least 1.5 cm 
away from the body. When a carry 
case, belt clip or holder is used for 
body-worn operation, it should not 
contain metal and should position the 
product at least 1.5 cm away from 
your body. In order to transmit data 
files or messages, this device requires 
a quality connection to the network. In 
some cases, transmission of data files 
or messages may be delayed until such 
a connection is available. Ensure the 
above separation distance instructions 
are followed until the transmission is 
completed. The highest SAR value for 
this device when tested for use at the 
body is 1.51 W/kg.

* The SAR limit for mobile devices used 
by the public is 2.0 watts/kilogram 
(W/kg) averaged over ten grams of 
body tissue. The guidelines incorporate 
a substantial margin of safety to give 
additional protection for the public 
and to account for any variations in 
measurements. SAR values may vary 
depending on national reporting 
requirements and the network band. 
For SAR information in other regions 

please look under product information 
at www.lgmobile.com.

Product care and 
maintenance

WARNING! 
Only use batteries, chargers and 
accessories approved for use with this 
particular phone model. The use of any 
other types may invalidate any approval 
or warranty applying to the phone, and 
may be dangerous.

]  Do not disassemble this unit. Take it 
to a qualified service technician when 
repair work is required.

]   Keep away from electrical appliances 
such as a TV's, radios or personal 
computers.

]  The unit should be kept away from 
heat sources such as radiators or 
cookers.

]  Never place your phone in a 
microwave oven as it will cause the 
battery to explode.

]  Do not drop.

]  Do not subject this unit to mechanical 
vibration or shock.

G
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]  The coating of the phone may be 
damaged if covered with wrap or vinyl 
wrapper.

]  Do not use harsh chemicals (such 
as alcohol, benzene, thinners, etc.) 
or detergents to clean your phone. 
There is a risk of this causing a fire.

]   Do not subject this unit to excessive 
smoke or dust.

]   Do not keep the phone next to 
credit cards or transport tickets; it 
can affect the information on the 
magnetic strips.

]  Do not tap the screen with a sharp 
object as it may damage the phone.

]  Do not expose the phone to liquid 
or moisture.

]  Use accessories, such as earphones 
and headsets, with caution. Ensure 
that cables are tucked away safely 
and do not touch the antenna 
unnecessarily.

]  Please remove the data cable before 
powering on the handset.

Efficient phone 
operation
To enjoy optimum performance 
with minimum power consumption 
please.

]   Do not hold the antenna when the 
phone is in use. If you hold it, it can 
affect call quality, it may also cause 
the phone to operate at a higher 
power level than needed and shorten 
talk and standby times.

Electronic devices
All mobile phones may get 
interference, which could affect 
performance.

]   Do not use your mobile phone near 
medical equipment without requesting 
permission. Avoid placing the phone 
over pacemakers (i.e. in your breast 
pocket.)

]   Some hearing aids might be disturbed 
by mobile phones.

]   Minor interference may affect TVs, 
radios, PCs, etc.

G
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Road safety
Check the laws and regulations on 
the use of mobile phones in the 
areas when you drive.

]   Do not use a hand-held phone while 
driving.

]   Give full attention to driving.

]   Use a hands-free kit, if available.

]   Pull off the road and park before 
making or answering a call if driving 
conditions so require.

]   RF energy may affect some electronic 
systems in your motor vehicle such as 
a car stereo or safety equipment.

]   If your vehicle is equipped with an air 
bag, do not obstruct it with installed 
or portable wireless equipment. It can 
cause serious injury due to improper 
performance.

If you are listening to music whilst 
outside and about, please ensure 
that the volume is at a reasonable 
level so that you are aware of your 
surroundings. This is particularly 
imperative when attempting to 
cross the street.

Avoid damage to your 
hearing
Damage to your hearing can occur if 
you are exposed to loud sound for 
long periods of time. We therefore 
recommend that you do not turn on or 
off the handset close to your ear. We 
also recommend that music and call 
volumes are set to a reasonable level.

Blasting area
Do not use the phone where blasting is 
in progress. Observe restrictions, and 
follow any regulations or rules.

Potentially explosive 
atmospheres
]   Do not use the phone at a refueling 

point. Don't use near fuel or 
chemicals.

]   Do not transport or store flammable 
gas, liquid, or explosives in the 
compartment of your vehicle, which 
contains your mobile phone and 
accessories.

G
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In aircraft
Wireless devices can cause 
interference in aircraft.

]  Turn off your mobile phone before 
boarding any aircraft.

]  Do not use it on the ground without 
crew permission.

Children
Keep the phone in a safe place out of 
small children's reach. It includes small 
parts which if detached may cause a 
choking hazard.

Emergency calls
Emergency calls may not be available 
under all mobile networks. Therefore, 
you should never depend solely on 
your mobile phone for emergency calls. 
Check with your local service provider.

Battery information and 
care
]  You do not need to completely 

discharge the battery before 
recharging. Unlike other battery 
systems, there is no memory effect 
that could compromise the battery's 
performance.

]  Use only LG batteries and chargers. 
LG chargers are designed to maximize 
the battery life.

]  Do not disassemble or short-circuit 
the battery pack.

]  Keep the metal contacts of the 
battery pack clean.

]  Replace the battery when it no longer 
provides acceptable performance. 
The battery pack may be recharged 
hundreds of times until it needs 
replacing.

]  Recharge the battery if it has not 
been used for a long time to maximize 
usability.

G
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]  Do not expose the battery charger 
to direct sunlight or use it in high 
humidity, such as the bathroom.

]  Do not leave the battery in hot or 
cold places, this may deteriorate the 
battery performance.

]  Risk of explosion if battery is replaced 
by an incorrect type.

]  Dispose of used batteries according 
to the manufacturer’s instructions. 

]  For use only with battery LG 
Electronics, KU380. 

G
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KU380 Features

Parts of the phone

Open view

Earpiece

Navigation keys  
] In standby mode:

 Profiles

  Messaging 
New message/Email(Press 
long)

 Quickmenu

 Contacts

]  In menu: Navigates menus.

VGA camera

LCD screen
]  Top: Icons showing signal 

strength, battery level and 
various other functions

]  Bottom: Soft key indications

Alpha numeric keys
]  In standby mode: Input 

numbers to dial. Hold down:
 for international calls.
 to dial voice mail 

centre.
 to  for speed 

dials.

]  In editing mode: Enter 
numbers & characters.

KU
380 Features
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Left soft key/ Right soft key
Performs the function indicated at the bottom 
of the display.

Confirm key
Selects menu options and confirms actions.

Send key 
]  Dials a phone number and answers a call.

]  In standby mode: Shows a history of calls made, 
received, and missed.

KU
380 Features



16

Left side view

Headset/Charger/Cable connector

KU
380 Features

KU380 Features
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Rear view

Battery

Battery cover

External camera 
lens

USIM card socket

KU
380 Features
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Getting Started

Installing the USIM card 
and battery
1. Installing the USIM card.
Your USIM card contains your phone 
number, service details and contacts 
and must be inserted into your handset. 
If your USIM card is removed then your 
handset becomes unusable (except for 
emergency calls) until a valid one is 
inserted. Always disconnect the charger 
and other accessories from your 
handset before inserting and removing 
your USIM card. Slide the USIM card 
into the USIM card holder. Make sure 
that the USIM card is properly inserted 
and the gold contact area on the card 
is facing downwards. To remove the 
USIM card, press down lightly and pull 
it in the reverse direction.

To insert the USIM card

To remove the USIM card

Note
]  The metal contact of the USIM card 

can easily be damaged by scratches. 
Pay special attention to the USIM 
card while handling. Follow the 
instructions supplied with the 
USIM card.

G
etting Started
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2. Installing the battery.
Slide the battery upwards until it snaps 
back into place.

3. To remove the battery.
Turn the power off. (If the power is left 
on, there is a chance you could lose 
the stored telephone numbers and 
messages.)

Press and hold down the battery 
release button and slide the battery 
down. 

G
etting Started
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Charging the Battery
Before connecting the travel adapter 
to the phone you must first install the 
battery.

1.  With the arrow facing you as shown 
in the diagram push the plug on the 
battery adapter into the socket on 
the left side of the phone until it 
clicks into place.

2.  Connect the other end of the travel 
adapter to the mains socket. 

Note
]  Only use the charger included in 

the box.

3.  The moving bars on the battery icon 
will stop after charging is complete.

4.  Ensure the battery is fully charged 
before using the phone for the first 
time.

CAUTION! 
•  Do not force the connector as this 

may damage the phone and/or the 
travel adapter.

•  If you use the battery pack charger 
when abroad, use an attachment plug 
adaptor for the proper configuration.

•  Do not remove your battery or the 
USIM card while charging.

WARNING! 
•  Unplug the power cord and charger 

during lightning storms to avoid 
electric shock or fire.

•  Make sure that no sharp-edged items 
such as animal teeth or nails, come 
into contact with the battery. This may 
cause a fire.

G
etting Started
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Disconnecting the 
charger
Disconnect the travel adapter from the 
phone as shown in the diagram below.

How to use a microSD 
memory card

<MicroSD memory card>

<How to insert a microSD memory 
card>
1.  Turn the phone off. Inserting or 

removing the microSD when the 
phone is on may damage the files 
stored in the memory card.

2.  Lift the plastic cover which protects 
the microSD slot.

3.  Insert the memory card into the slot. 
The gold contacts must be kept on 
the back of the microSD. Don’t push 
the microSD too much. If it doesn't 
go into the slot easily, you may be 
trying to insert it in the wrong way 
or there could be a foreign object 
in the slot.

4.  Once inserted, push the memory 
card until you hear a Click, meaning 
that the microSD has been correctly 
engaged.

G
etting Started
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5. Close the plastic slot protection.

6.  To remove the memory card, 
turn the phone off, open the slot 
protection and push the microSD 
to unlock it. Carefully extract the 
memory card.

Attention:
]  Avoid using the Flash Memory Card 

when the battery is low.

]  When writing to the card, wait for 
the operation to complete before 
removing the card.

]  The card is designed to fit easily into 
the system one way only.

]  Do not bend the card or force it into 
the slot.

]  Do not insert any memory cards other 
than those made by microSD.

]  If the microSD has been formatted 
using FAT32, format the microSD 
using FAT16 again. 

For more information on the microSD, 
please refer to the memory card 
instruction manual.

Memory card formatting
Before you start to use the memory 
card you have to format it. After you 
insert the memory card, select Menu 
> Settings > Memory manager > 
External memory, then press  the 
left soft key. 

This operation should only be done 
when you insert the memory card for 
the first time. During formatting various 
folders will be created for different 
data types.

Turning Handset 
ON/OFF
Turning your handset on
Ensure that your USIM card is in your 
handset and the battery is charged. 
Press and hold  until the power 
comes on. Enter the USIM PIN code 
that was supplied with your USIM card 
if the PIN code request is set to On. 
(Note: Please refer to page 92) 
After a few seconds you will be 
registered on the network.

G
etting Started
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Turning your handset off 
Press and hold  until the power goes 
off. There may be a few seconds delay 
while the handset powers down.
Do not turn the handset on again 
during this time.

Access codes
You can use the access codes described 
in this section to avoid unauthorised 
use of your phone. The access codes 
(except the PUK and PUK2 codes) 
can be changed by using the Change 
codes feature [Menu 7.7.3].

PIN code (4 to 8 digits)
The PIN (Personal Identification 
Number) code protects your USIM card 
against unauthorised use. The PIN code 
is usually supplied with the USIM card. 
When the PIN code request is set to 
On, your phone will request the PIN 
code every time it is switched on. When 
the PIN code request is set to Off, 
your phone connects to the network 
directly without the PIN code.

PIN2 code (4 to 8 
digits)
The PIN2 code, supplied with some 
USIM cards, is required to access 
functions such as Fixed dial number. 
These functions are only available if 
supported by your USIM card.

PUK code (8 digits)
The PUK (PIN Unblocking Key) code 
is required to unblock a blocked PIN 
code. The PUK code may be supplied 
with the USIM card. If not, contact 
your network operator’s customer 
service department for the code. 
If you lose the code, contact your 
network operator’s customer service 
department.

PUK2 code (8 digits)
The PUK2 code, supplied with some 
USIM cards, is required to unblock a 
blocked PIN2 code. If you lose the 
code, contact your network operator’s 
customer service department.

G
etting Started
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Security code (4 digits)
The security code prevents 
unauthorised use of your phone. The 
default security code is set to ‘0000’ 
and the security code is required to 
delete all phone entries and to restore 
the handset to the factory settings.

Display information
No USIM idle screen
This is the initial screen of the phone 
that appears when there is no USIM 
card installed in the phone, or the 
installed USIM card is invalid. In this 
screen, users can only make emergency 
calls, and turn the phone off. To turn 
the phone off, press and hold down  
for a few seconds.

Screen structure
If there is no USIM card installed, an 
animation telling you to insert a USIM 
card appears. If the USIM card inserted 
into the phone is invalid, an animation 
telling you that the USIM card is 
Inactive /Emergency call appears.

Emergency call function
The right soft key is represented by 
“Emergency” on the screen. Press the 

right soft key or dial your emergency 
number using the number keys, and then 
press  to make an emergency call.

Idle screen
The idle screen appears when you 
have installed a proper USIM card and 
turned the phone on.

Screen structure
Idle screen consists of the operator's 
name, indicators, date and time on a 
background image. You can change the 
wallpaper in the Screen theme menu.

Numbering screen
The numbering screen appears when 
a number key is pressed in the idle 
screen.

Screen structure
The numbering screen consists of 
status indicators, dialled number and 
soft menu. Status indicators are the 
same as those of the idle screen. You 
can change the size and colour of the 
dialling font in the Screen theme 
menu. You can make a call during a call 
by pressing .

G
etting Started
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Soft key
You can use the soft keys for several 
functions while dialling a number. Using 
the left soft key, you can make a video 
call, send a message to the number, 
save the number to Contacts, search 
contacts.

Handset lock screen
When the Handset lock function 
is selected, you can only make an 
emergency call, release the lock, and 
turn off the phone in this screen. As 
always, you can turn the phone off 
by pressing and holding  for a few 
seconds.

Screen structure
The screen structure of the Handset 
lock screen is the same as that of the 
idle screen.

Emergency call function
You can make an emergency call using 
the right soft key. As with the No 
USIM idle screen, only emergency 
numbers can be dialled.

Unlock function
If you press key except right soft 
key and number key, a popup screen 
appears asking you to input the 

Security code to unlock the phone. 
The Security code is configured in 
the Change codes (#. Settings > 6. 
Security > 3. Change codes). If you 
key in an incorrect Security Code, the 
phone will remain in Handset lock 
status. If you key in the correct Security 
code, the phone will be unlocked, and 
the idle screen will be displayed. If 
you have turned the phone off in the 
Handset lock status, you will find the 
phone remains in Handset lock status 
when you turn it on. 

Barring password
This service obstructs calling service 
in some conditions. This condition 
can be edited using the Call barring 
feature (2. Calling > 7. Call barring). 
The barring password is required when 
you use the call barring function. 
The password is obtained from your 
network operator's customer service 
when you subscribe to this service. 
While this service is activated, the caller 
will hear the information message that 
the call is not connected because of the 
call barring.

G
etting Started
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General Functions

Making and answering 
calls
Making a voice call
1.  Enter the number including the full 

area code.

]  To delete a digit press . 
To delete all digits press and 
hold .

2. Press  to make the call.

3.  Press  to finish the call, or close 
the handset.

Note
]  To activate the speakerphone 

during a call, activate the touch 
keys and press .

Making a call from the call logs
1.  In standby mode, press  and the 

latest incoming, outgoing and missed 
phone numbers will be displayed.

2.  Select the desired number by using 
 / .

3. Press  to call the number.

Making a video call
You can make a video call in a 3G 
covered service area. If the called user 
has a 3G video phone in a 3G covered 
service area, the call will be established. 
You can also answer a video call for 
video incoming call. To make/answer a 
video call, do the following.

1.  Input the phone number using the 
keypad, or select the phone number 
from the calls made/received lists.

]  To correct mistakes, press  
briefly to delete the last number, 
or press and hold  to delete all 
numbers.

2.  If you do not want to use the 
speakerphone, ensure you have the 
headset plugged in.

3.  To start the video function, press 
the left soft key [Options] and select 
Make video call.

]  You will be notified that you will 
need to close other applications to 
make the video call.

G
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Note
]  The video call may take some time 

to connect. Please be patient. The 
connection time will also depend 
on how quickly the other party 
answers the call. While the video 
call is connecting, you will see your 
own image; after the other party 
has answered, their image will be 
displayed on the screen.

4.  Adjust the camera position if 
necessary.

5.  Press  to finish the call, or close 
the handset.

Making a voice/video call from 
Contacts
It is easy to call anyone whose number 
you have stored in your Contacts.

1. Press  to access the contacts list.

2. Scroll to the contact to make a call.

3.  Press  to make a voice call. Press 
the left soft key and select Make 
video call to make a video call. 

4. Press  to finish the call.

Making international calls
1.  Press and hold  for the 

international prefix. The ‘+’ character 
prefixes the international access 
code.

2.  Enter the country code, area code, 
and the phone number.

3. Press .

Answering a call
When you receive a call, the phone 
rings and the flashing phone icon 
appears on the screen. If the caller can 
be identified, the caller’s phone number 
(or name if stored in your Contacts) is 
displayed.

1.  Open the slider to answer an 
incoming call.

Note
]  To reject an incoming call, press 

 or the right soft key twice.

]  If you set Answer mode as Press 
send key (Menu 2.0.4), you can 
answer the call by pressing  
after opening the slider.

]  If the answer mode is set to Press 
any key, any key will answer a call 
except for .

G
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2.  End the call by closing the handset 
or pressing .

Note
]  You can answer a call while using 

the Contacts or other menu 
features.

]  When the compatible headset is 
connected, you can also answer a 
call using the headset key, as well 
as using the phone. To reject an 
incoming call, press .

]  You can mute the ringtone when 
a call comes in by pressing and 
holding the volume right soft key.

Shortcut to activate vibrate mode
You can activate the vibrate only mode 
by pressing and holding down  
after opening the phone.

Signal strength 
You can check the strength of your 
signal by the signal indicator on the 
LCD screen of your phone. Signal 
strength can vary, particularly inside 
buildings. Moving close to a window 
may improve reception.

Entering text
You can enter alphanumeric characters 
using the keypad.
For example, storing names in Contacts, 
writing a message, creating a personal 
greeting or scheduling events in the 
calendar all require entering text.
The following text input methods are 
available with the handset.

G
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Changing the text input mode 
1.  When you are in a field that allows 

characters to be entered, you will 
notice the text input mode indicator 
in the upper right corner of the LCD 
screen.

2.  If T9 is on, you can change the mode 
to T9Abc, T9ABC, 123, T9abc by 
pressing . When T9 is off, the 
mode will be changed to Abc, ABC, 
123, abc.

Using the T9 Mode
The T9 predictive text input mode 
allows you to enter words easily with 
a minimum number of key presses. As 
you press each key, the handset begins 
to display the characters that it thinks 
you are typing based on a built-in 
dictionary. As new letters are added, 
the word changes to reflect the most 
likely candidate from the dictionary.

1.  When you are in the T9 predictive 
text input mode, start entering a 
word by pressing  to . Press 
one key per letter.

T9 mode 
This mode lets you enter words 
with only one keystroke per 
letter. Each key on the keypad 
has more than one letter. The T9 
mode automatically compares 
your keystrokes with an internal 
dictionary to determine the correct 
word, thus requiring far fewer 
keystrokes than the traditional ABC 
mode. This is sometimes known 
as predictive text. If you press 

 key for a long time, you can 
activate or cancel T9 mode.

ABC mode 
This mode lets you enter letters 
by pressing the key labelled with 
the required letter once, twice, 
three or four times until the letter 
is displayed.

123 mode (Number mode)
Type numbers using one keystroke 
per number. 

G
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]  The word changes as letters are 
typed. Ignore what’s on the screen 
until the word is typed completely.

]  If the word is still incorrect after 
typing completely, press once 
or more to scroll through the other 
word options.

Example

Press  to type 
Good.
Press  to get Home.

]  If the desired word is missing from 
the word choices list, add it by 
using the ABC mode.

2.  Enter the whole word before editing 
or deleting any keystrokes.

3.  Complete each word with a space by 
pressing .

To delete letters, press . 

Using the ABC Mode
Use  to  to enter your text.

1.  Press the key labelled with the 
required letter:

]  Once for the first letter.

]  Twice for the second letter.

]  And so on.

2.  To insert a space, press  once. 
To delete letters, press . 

Refer to the following table for more 
information on the characters available 
using the alphanumeric keys.

Key
Characters in the order display

Upper case Lower case

. , / ? ! - : ' " 1 . , / ? ! - : ' " 1

A B C 2 À Â Æ Ç a b c 2 à â æ ç 

D E F 3 É È Ê Ë d e f 3 é è ê ë

G H I 4 Î Ï g h i 4 î ï

J K L 5 j k l 5 

M N O 6 Ñ Ô Ö Œ m n o 6 ñ ô ö œ

P Q R S 7 p q r s 7

T U V 8 Û t u v 8 û

W X Z Y 9 Ŵ Ŷ w x y z 9 ŵ ŷ

Space, 0 Space, 0

Note
]  The characters assigned to the 

keys and their order of appearance 
depends on the language selected 
using the option Input method. The 
table above provides the characters 
set for English language.
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Using the 123 (Number) mode
The 123 mode enables you to enter 
numbers in a message(a telephone 
number, for example). Press the keys 
corresponding to the required digits 
before manually switching back to the 
appropriate text entry mode.

Using the symbol mode
The symbol mode enables you to enter 
various symbols or special characters. 
To enter a symbol, select Options > 
Insert > Symbols. Use the navigation 
and numeric keys to select the desired 
symbol and press .

G
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Overview of Menu Functions

O
verview of M

enu Functions

1. Games & Apps

1.1  My games & apps
1.2 Settings

2. Calling

2.1 Make video call
2.2 Call logs
2.3 Call durations
2.4 Data volume
2.5 Call costs
2.6 Call divert
2.7 Call barring
2.8 Fixed dial numbers
2.9 Call waiting
2.0 Common settings
2. Video call setting

3. Organiser

3.1 Calendar
3.2 To do
3.3 Memo
3.4 Secret memo
3.5 Settings

4. Multimedia

4.1 Camera
4.2 Video camera
4.3 Music
4.4 Voice recorder

5. Messages

5.1  Create new 
message

5.2 Inbox
5.3 Mailbox
5.4 Drafts
5.5 Outbox
5.6 Sent items
5.7 Templates
5.8 Emoticons
5.9 Settings

6. My stuff

6.1 My images
6.2 My sounds
6.3 My videos
6.4 My games & apps
6.5 Others
6.6 My memory card

* is displayed depending on the country.
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O
verview of M

enu Functions

7. Google

8. Contacts

8.1 Add new
8.2 Search
8.3 Speed dials
8.4 Groups
8.5  Service dial 

numbers
8.6 Own number
8.7 My business card
8.8 Settings

9. Tools

9.1 Quick menu
9.2 Alarms
9.3 Calculator
9.4 Converter
9.5 World time
9.6 STK(USIM service)

0. Connectivity

0.1 Bluetooth
0.2 Synchronisation
0.3  USB connection 

mode  

. Browser

.1 Home

.2 Enter address

.3  Bookmarks

.4 Saved pages

.5 History

.6 Settings

#. Settings

#.1 Profiles

#.2 Phone  

#.3 Screen

#.4 Date & Time 

#.5 Flight mode

#.6 Network

#.7 Security

#.8 Memory manager

#.9 Reset settings
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Games & Apps [Menu 1] 

My games & apps Menu 1.1

You can easily download games and 
other applications in this menu. It 
may have two folders, no folders at 
all, or Games and Applications. The 
default folder can be dependent on 
the operator/country. Each folder has 
an embedded link for downloading 
games or applications. Please note that 
additional costs may be incurred when 
using online services. You can create a 
folder using the left soft key [Options].

Settings  Menu 1.2

Activating a profile
1.  Move the cursor to the profile you 

would like to activate.

2. Press .

Adding a new profile
1.  Select Add new from the Options 

menu. The following items need to 
be configured.

Service name Enter an account name 
for the profi le.

Connection 
mode 

Choose from the given 
list of connection modes. 
(Default is TCP with 
Proxy or TCP without 
Proxy)

IP address Enter the WAP Gateway 
IP address provided by 
the operator. (e.g. 195. 
115. 025. 129)

Proxy server 
port 

Port details are pro-
vided by the operator, 
depending upon the 
Connection mode.

Access point Choose from the given 
list of access points. (For 
more details on adding 
or editing a new access 
point, refer to page 91.)

2.  Press the [Save] to save any 
configuration changes.

You can edit and delete a profile by 
selecting Edit and Delete from the 
Options menu.

G
am
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Calling [Menu 2]

Make video call  Menu 2.1

You can make a video phone call in 
this menu. For details, refer to page 
37 to 38.

Call logs  Menu 2.2

All calls   (Menu 2.2.1)

Allows you to view the missed, received, 
and dialled call records. You can make 
a call, or send a message to the number 
you have selected from the records. 
You can also save the number in 
Contacts.

Dialled calls (Menu 2.2.2)

Allows you to view dialled call records, 
make a call, send a message, and save 
the number in Contacts.

Received calls (Menu 2.2.3)

Allows you to view received call records, 
make a call, send a message, and save 
the number in Contacts.

Missed calls (Menu 2.2.4)

Allows you to view missed call records, 
make a call, send a message, and save 
the number in Contacts.

Call durations  Menu 2.3

You can view call time by types. Press 
the left soft key [Options] to choose 
either partial initialisation or entire 
initialisation. Initialization will require 
your Security code.

The following timers are available:

All calls   (Menu 2.3.1)

Shows total call time.

Dialled calls  (Menu 2.3.2)

Shows outgoing call time.

Received calls  (Menu 2.3.3)

Shows incoming call time.

Last call  (Menu 2.3.4)

Shows the latest call time in units of 
hours/minutes/seconds.

Calling
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Data volume Menu 2.4

Allows you to check the sent, received 
and all data volume transferred.

Press the left soft key [Options] to 
chose [Clear all] to choose entire 
initialization. You can also use the 
[Clear] for the initialization of the 
selected volume type. Initialization will 
require your Security code.

Call costs Menu 2.5

1.  This function displays the call costs 
of the Last call and All calls.

2.  Press the left soft key [Options] to 
choose either partial Initialization or 
entire Initialization. Initialization will 
require the PIN2 code.

3.  You can select either Units 
or Currency in Set call cost. 
According to your setting, the call 
cost is displayed during a call (If 
USIM and Network support Advice 
Of Charge(AOC)).

4.  In the Set limit configuration, select 
On to configure the cost limit. When 
a cost limit is configured, and the call 
costs reach the limit, making a call 
will not be allowed.

Call divert  Menu 2.6

Call divert menus for voice and video 
calls are provided.

If you press , you can activate call 
divert menu.

Voice calls
All voice calls

When busy

No answer

Not reachable

1.  When the number list is not 
existing 
Converts to an editor for entering 
a divert number. You can input the 
number to divert a call directly or 
search it in phonebook. If you press 

[Divert], the phone will send the 
request to service provider after 
entering the number. While waiting 
for the result from the network, a 
Requesting message and animation 
appears.

2.  When the number list is existing
Displays To other number menu 
including of the number list. While 
waiting for the result from the 
network, a Requesting message and 
animation appears.

Calling

Calling
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3.  Option menu
After activating All voice calls menu, 
selecting the Options menu at the 
bottom of the menus displays the 
Deactivate,  Deactivate all, View 
status and clear list menus. The View 
status menu shows the settings on 
the network. If you select this menu, 
Requesting. message and animation 
appear. Then the network settings 
are displayed when the information 
is received from the network. If you 
select the Deactivate menu, the 
call divert numbers registered in 
the network are deleted after user 
confirmation. Clear list menu will 
delete all divert number list.

Video calls
All video calls

1.  When the number list is not 
existing  
Converts to an editor for entering 
a divert number. You can input the 
number to divert a call directly or 
search it in phonebook. If you press 

[Divert], the phone will send the 
request to service provider after 
entering the number. While waiting 
for the result from the network, a 
Requesting message and animation 
appears.

2.  When the number list is existing
Displays To other number menu 
including of the number list. While 
waiting for the result from the 
network, a Requesting message and 
animation appears.

3.  Option menu
After activating the All video calls 
menu, selecting the Options menu 
at the bottom of the menus displays 
the Deactivate, Deactivate all, View 
status and clear list menus.
If you select the Deactivate menu, 
the call divert numbers registered in 
the network are deleted after user 
confirmation. Selecting the Cancel 
all menu will display the operation 
result after showing the Requesting 
message and animation. Clear list 
menu will delete all divert number 
list.

When busy

1.  When the number list is not 
existing
It operates the same as All voice 
calls menu.

2.  When the number list is existing
It operates the same as All voice 
calls menu.

Calling
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3.  When Option menu is selected
It activates and operates If busy 
menu. It operates the same as All 
voice calls menu.

No answer
1.  When the number list is not 

existing
It operates the same as All voice 
calls menu.

2.  When To a number is selected
It operates the same as All voice 
calls menu.

3.  When Option menu is selected
Activates and operates No answer 
menu. It operates the same as All 
voice calls menu except that users 
can configure delay time in the Set 
waiting time menu in the menu list.

Not reachable

1.  When the number list is not 
existing
It operates the same as All voice 
calls menu.

2.  When the number list is existing
It operates the same as All voice 
calls menu.

3.  When Options menu is selected
Activates and operates If out of 
reach menu. It operates the same as 
All voice calls menu.

Call barring Menu 2.7

Call barring menus for Voice and Video 
calls are provided.

The menu consists of Voice calls, 
Video calls and Deactivate all. The 
Voice calls and Video calls menus have 
the following submenus.

The Call barring menu consists of All 
outgoing, Outgoing international, 
Outgoing international calls except 
home country, All incoming and 
Incoming when abroad submenus. 

The All outgoing menu bars dialling 
all outgoing calls, the Outgoing 
international menu bars dialling 
outgoing international calls, and the 
Outgoing international calls except 
home country menu bars dialling 
outgoing international calls except for 
the Home PLMN country. All incoming 
rejects all incoming calls and the 
Incoming when abroad menu rejects 
incoming calls when roaming.

Calling
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Voice calls

Video calls
All outgoing

1.  When  is selected, it receives 
the Barring password from user, 
and activates the barring service on 
the network. A requesting message 
and animation appears. When the 
network answers, the result of the 
operation is displayed.

2.  When the Options menu is selected, 
it activates the Outgoing calls menu. 
Select the Options menu from the 
soft menus on the lowest menu. 
Then Deactivate, Deactivate all, 
View status and Change password 
menus appear. The Deactivate 
menu deactivates the barring service 
after the user's Barring password is 
entered. The Deactivate all menu 
deactivates all barring services 
configured in the network after the 
user's Barring password has been 
entered. The View status menu 
enables users to view the current 
network configuration. Selecting 
View status menu displays the 
Requesting message with animation 
and the result of the operation 
when the network answers. Change 

password menu enables users to 
change the current barring password.

Outgoing international

1.  When  is selected, it operates 
in the same way as the Outgoing 
calls menu.

2.  When the Options menu is selected, 
it activates and operates the 
International calls menu. It operates 
in the same way as the Outgoing 
calls menu.

Outgoing international calls except 
home country

1.  When  is selected, it operates 
in the same way as the Outgoing 
calls menu.

2.  When the Options menu is selected 
– It activates and operates the 
International except home 
country menu. It operates in the 
same way as the Outgoing calls 
menu.

All incoming

1.  When  is selected, it operates 
in the same way as the Outgoing 
calls menu.

Calling
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2.  When the Options menu is selected, 
it activates and operates the 
Incoming calls menu. It operates 
in the same way as the Outgoing 
calls menu.

Incoming when abroad

1.  When  is selected, it operates 
in the same way as the Outgoing 
calls menu.

2.  When the Options menu is selected, 
it activates and operates the 
Incoming calls when abroad menu. 
It operates in the same way as the 
Outgoing calls menu.

Fixed dial numbers
 Menu 2.8

] Turn on/ Turn off

-  On: Select whether to activate 
FDN or not. PIN2 authentication 
is required.

-  OFF: Select whether to activate 
FDN or not. PIN2 authentication 
is required.

]  FDN list: Displays the current FDN 
list. You can edit, add, or delete fixed 
dial numbers. PIN2 authentication is 
requried to edit,add, or delete the list. 
And the configuration information is 
saved on the USIM. The information 
saved on the USIM is used when FDN 
restricts outgoing calls.

Call waiting Menu 2.9

]  Activate: Activates waiting service. 
Selecting this item, displays 
requesting message and animation. 
When the network answers, the result 
of the operation is displayed.

]  Deactivate: Deactivates Call waiting 
service. Selecting this item displays 
requesting message and animation. 
When the network answers, the result 
of the operation is displayed.

]  View status: Displays activated Call 
waiting service group item of the 
network. Selecting this item displays 
requesting message and animation. 
When the network answers, the result 
of the operation is displayed.

Calling

Calling
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Common settings Menu 2.0

Call reject
You can set whether to reject incoming 
calls.

1.  Select On in Reject menu to activate 
call reject. The Reject list menu 
appears.

2.  Set the desired call reject option in 
the Reject list menu.

] All calls: Rejects all calls.

]  Contacts: Rejects the calls from the 
number stored in Contacts.

]  Groups: You can specify call rejects 
by group units stored in Contacts.

]  Unregistered: Rejects calls from the 
number not stored in Contacts.

]  No caller ID: Reject calls which do 
not have CLI information.

Send my number
]  Set by network: Configures with the 

default settings determined by the 
service provider.

]  On: Configures to send my phone 
number when making an outgoing call.

]  Off: Configures not to send my 
phone number when making an 
outgoing call.

Auto redial
Allows you to set the auto redial 
function when a call attempt has failed.

Answer mode
Allows you to set the answering 
method. You can choose between 
Press send key, Slide up and Press 
any key.

Minute minder
Determines whether to sound a 1 
minute tone every 1 minute when you 
are on the phone.

Calling
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BT answer mode
]  Hands-free: You can answer a call 

using the Bluetooth headset, when 
the Bluetooth is connected.

]  Handset: If you press  on the 
handset to answer a call, you can 
talk on the handset. If you press the 
Bluetooth headset key to answer a 
call, you can talk using the Bluetooth 
headset. This is the initial answer 
mode selection. And while talking, you 
can switch from handset to headset 
or from headset to handset.

Save new number
In this menu, you can save the phone 
number when ending a call if the phone 
number is not saved in a phonebook.

Slide close setting 
when the slide is down, you can set the 
call is ended or not.

Video call setting Menu 2.

You can set the screen display when 
making /receiving a video call.

]  Use private picture: Determine 
whether to show the private image 
or not.

]  Select private picture: Select the 
still image to be displayed.

]  Mirror: Select to activate the mirror 
effect or not.

-  On: Displays the image flipped 
side to side.

- Off: Displays the image as it is.

]  My image size: Select my image size 
to be displayed.

]  My image position: Select the 
position where your image will be 
displayed.

Calling
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Organiser [Menu 3]

Calendar  Menu 3.1

Schedule inquiry and search
1.  Reference by Months

You can refer to your schedule by 
months. The cursor is on the current 
date, and the registered date is 
marked. The schedule saved for the 
date where the cursor is located is 
represented by a grey box. Pressing 
the shortcut key  moves to the 
previous year and pressing  
move to the next year and pressing 

 moves to today. Pressing  
moves to the previous month, and 

 moves to the next month. 
Pressing  moves to the weekly 
calendar. You can move the date 
using  /  /  / .

2.  Detailed reference
You can refer to a detailed schedule, 
that is the whole contents of the 
schedule configured by the user. 
You can send the schedule to 
another phone or an Internet site 
through SMS (Text message) or 
MMS (Multimidia message) or Email 
or Bluetooth using the left soft key 
[Options].

Add new event
You can add an event. You can 
configure the start date, end date, start 
time, end time, contents, type of event, 
repetition, alarm of the schedule.

]  Set type: Appointment, Anniversary, 
Birthday 

]  Set repeat: Once, Daily, Weekly, 
Monthly, Annually, User setting

]  Set alarm: No alarm, On time, 15 
mins before, 30 mins before, 1 hour 
before, 1 day before, 3 days before, 
1 week before

Delete all schedules
You can delete all saved schedule 
contents using this function.

Set up and release holiday
You can set up or release user holidays. 
Press the left soft key [Options] and 
select Set holiday. The selected date 
will be displayed in red.

To release the holiday, press the left 
soft key [Options] and select Clear 
holiday.

O
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Schedule notification
If the user has configured the alarm 
setting, the specified alarm sound will 
ring. If the notification time is before 
the schedule start time, you can set up 
the alarm again.

To do   Menu 3.2

You can view, edit and add tasks to 
do. Tasks are displayed in time order. 
Tasks that have been completed or not 
completed are displayed in different 
ways.

Add new event
To add a task, press the left soft 
key [Options] in the To do list 
management screen and select Add 
new event option. Then input the 
date, description and priority for the 
task. When you have finished entering 
the data, press the centre key [Save] to 
save the new task.

Detailed view and Edit
To view detailed to do contents, locate 
the cursor on the desired item in the 
Tasks list, and then press the centre 
key. You can send, edit and delete a 
task using the left soft key [Options].

Set job status
Tasks set as finished are displayed as 
crossed out below the unfinished tasks 
in the Tasks list. You can set Finished 
tasks to Not finished by selecting 
Options.

Memo  Menu 3.3

Using the memo management function, 
you can view and manage saved memo 
contents, and add new memo.

Add memo
To add a new memo, press the left 
soft key [Add] or [Add new memo] 
in Options. Enter the contents of the 
memo. You can save the memo to the 
list by pressing the centre key [Save].

Edit and delete memo
Highlight the desired memo and press 

 to view its contents. You can edit 
or delete the contents of a memo 
using the left soft key [Options]. You 
can return to the memo management 
screen by pressing right soft key 
[Back]. You can select Multiple or All 
memos using the Mark/Unmark option 
and then delete a memo using the 
Delete option.

O
rganiser
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Secret memo  Menu 3.4

You can write the private memo to 
protect your privacy. You enter the 
security code to use this menu.

Add private memo
To add a new memo, press the left 
soft key [Add] or [Options]. Enter the 
contents of the memo. You can save 
the memo to the list by pressing the 
centre key [Save].

Edit and delete a private memo
Highlight the desired memo and press 

 to view its contents. You can edit 
or delete the contents of a memo 
using the left soft key [Options]. You 
can return to the memo management 
screen by pressing right soft key 
[Back]. You can select Multiple or All 
memos using the Mark/Unmark option 
and then delete a memo using the 
Delete option.

Settings  Menu 3.5

Calendar (Menu 3.5.1)

You can set the configurations to view 
the calendar.

]  Default view: You can set the 
default value to view a calendar; 
Month view, Week view

]  Week start time: 1AM, 2AM, 3AM, 
4AM, 5AM, 6AM, 7AM, 8AM, 9AM, 
10AM, 11AM, 12PM

]  Week starts on: You can set the 
default day to start a week; Sunday, 
Monday

Backup calendar & To do
 (Menu 3.5.2)

You can create the backup files of 
the calendar or to do list saved in the 
phone when you insert an external 
memory.

Restore calendar & To do
 (Menu 3.5.3)

You can reset the backup files of 
calendar or tasks when you insert an 
external memory.

O
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Memory info. (Menu 3.5.4)

You can view the infrmation of available 
memory regarding Calendar, Tasks, 
Memo and Secret memo.

Clear all (Menu 3.5.5)

You can delete all data regarding 
Calendar, Tasks, Memo and Secret 
memo.

Organiser
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Multimedia [Menu 4]

Camera Menu 4.1

This application enables you to take a still picture. You can take a picture in the 
size you want, and use it for the address book photo, home screen and other 
more general purposes. Once taken, the picture can be sent by Message, Email or 
Bluetooth .

Options Take Back

Press  to take a picture.

Brightness: From –2.0 to 2.0 at 0.5 intervals. The 
higher the level, the brighter the screen.

1.  Press the left soft key to access Options and set the desired environment as 
follows. 

   ] Move between the options menus with  / . 

   ] Select the desired value with  /  and confirm the selection with .

M
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Menu Description

Go to The Pictures folder is launched 
and displays existing pictures 
as thumbnails.
You can view pictures by 
pressing . You can also 
send the selected picture to 
another party via Message, 
EMail or Bluetooth.

Size 1280x960, 640x480, 
320x240, Wallpaper, 
176x144, Contact 

Quality Super fi ne,Fine,Standard

Burst shot One, Three, Six, Nine
(Note: Available Burst shot 
depends on the size.)

Brightness From –2.0 to 2.0 at 0.5 
intervals. The higher the level, 
the brighter the screen. 

White 
balance

You can adjust the tone of the 
background photo according 
to the weather.
Auto, Daylight, Cloudy, Illumi-
nate, Indoors

Menu Description

Night 
mode

You can take better pictures at 
night by selecting On.

Frame 
Shot

You can apply one of 10 frame 
effects when taking a picture. 
(available only in case of 
Wallpaper size)

Timer You can delay the camera 
shutter time. None, 3 secs., 
5secs., 10 secs.
“ ” is shown when the timer 
is activated.

Effect None, Black & White, Nega-
tive, Sepia

Sound Select the desired shutter 
sound.

Memory Select the desired memory, 
either Handset or External.

Mirror  You can activate the mirror 
effect by selecting On.

Swap cam You can switch the camera to 
activate either the Internal or 
the External camera. 

M
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2. After finishing all the settings, press the right soft key [Close].

3. Focus the camera on what you want to take and press .

4. Press  to save the picture. It is saved in the Pictures folder of My Files. 

Note
Press the right soft key [Back] to go back to the preview mode without 
saving the picture.
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Video camera Menu 4.2
This application enables you to record a video clip. You can play and watch a saved 
video file in this menu. Once recorded, a video clip can be sent by Message, Email 
or Bluetooth.

Options Rec. Back

Brightness: From –2.0 to 2.0 at 0.5 intervals. The 
higher the level, the brighter the screen.

Press the  to record the image.

1.  Press the left soft key to access Options and set the desired environment as 
follows. 

   ] Move between the options menus with  / . 

   ] Select the desired value with  /  and confirm the selection with .

M
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Menu Description

Go to The Videos folder is launched 
and displays existing videos as 
thumbnails. 
You can view videos by press-
ing . You can also send 
the selected video to another 
party via Message, Email or 
Bluetooth.

Size 176x144, 128x96

Quality Super fi ne,Fine,Standard

Brightness From –2.0 to 2.0 at 0.5 
intervals. The higher the level, 
the brighter the screen. 

White 
balance

You can adjust the tone of the 
background video according to 
the weather.
Auto, Daylight, Cloudy, Illumi-
nate, Indoors

Menu Description

Night 
mode

You can take better shots at 
night by selecting On.

Effect None, Black & White, Nega-
tive, Sepia

Duration Select the desired recording
time. 
MMS, 30 secs., 1min,
2mins., 5mins., 60 mins.

Memory Select the desired memory, 
either Handset or External.

Mirror You can activate the mirror 
effect by selecting On.

Sound Decide whether to record the
sound or not.

Swap cam  You can switch the camera 
to activate either Internal or 
External.

2. After finishing all the settings, press the right soft key [Close].

3.  Focus the camera on what to record and press to start recording. 
And press  to stop recording.

    ] You can pause the recording by pressing the left soft key [Pause].

4. Press  to save the video clip. It is saved in the Videos folder of My Files. 

Note
Press the right soft key [Back] to go back to the preview mode without 
saving the video clip.

M
ultim

edia



52

Music Menu 4.3

Recently played (Menu 4.3.1)

This menu shows the last 20 tracks 
that were played. And, if it starts to 
play, the menu "Now playing" will be 
displayed.
You can activate media player on 
playing through Now playing menu.

All tracks (Menu 4.3.2)

You can view all the music files stored 
in the phone/external memory.

Playlists (Menu 4.3.3)

You can create your own playlists by 
choosing tracks from the All tracks 
menu list.

Artists (Menu 4.3.4)

You can view and play music sorted 
by Artists.

Albums (Menu 4.3.5)

You can view and play music sorted 
by Albums.

Genres (Menu 4.3.6)

You can view and play music sorted 
by Genres.

Shuffle tracks (Menu 4.3.7)

If you want to play the music 
continuously and randomly, select this 
option.

Voice recorder Menu 4.4

1.  Press the left soft key [Option] to 
display the option pop up menu 
before recording.

2.  Move to the desired menu item using  
 /  and press .

]  Duration: You can set the 
recording duration to MMS msg. 
size, 30 secs, or 1 min.

]  Quality: You can select a 
recording quality from Super fine, 
Fine, and Normal.
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]  Go to my sounds: Opens the 
Voice recordings folder in Sounds.

3.  Pressing  starts recording. When 
a recording is started, the recording 
time appears on the LCD. To cancel 
the recording, press the Back.

4.  When you finish the recording, 
press  to exit. The recorded file 
is automatically saved in the Voice 
recordings folder in My files. If 
you press  again, you can start 
recording new voice.

5.  Press the left soft key to select 
the various options after the voice 
recording.

6.  Select the desired menu using  / 
 and press .

]  Send: To send the recorded file. 
Select one from Message, Email 
and Bluetooth using  /  and 
press .

]  Use as: You can set the recorded 
file as the Voice Ringtone, Video 
Ringtone. 

]  Move: You can move the voice 
record to the other folder. 

]  Copy: You can copy the voice 
record.

]  Delete: Select this menu to delete 
a recorded file.

]  Mark/Unmark: You can select 
one or more files for multiple 
deletion. 

]  File: You can change the name of 
file and view the information.

]  Sort by: You can sort the files by 
date, file type or name.

]  Memory manager: Displays 
the memory status (handset or 
external memory card).

7.  Press the right soft key to close the 
sub-menu popup window.
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Messages [Menu 5]

Create new message
 Menu 5.1

Message  (Menu 5.1.1)

You can write and edit a message 
containing a combination of text, image, 
video and audio.

1.  Enter your message in the Message 
field.

Options menus in Message field

]  Insert: You can perform the 
following actions:

1.  Image: You can insert an image. 
(Existing image/Take picture)

2.  Video: You can insert a video 
clip. (One video clip per slide)

3.  Sound: You can insert a sound 
file. (One sound per slide)

4.  Symbols: You can insert 
symbols. After entering the 
corresponding number keys, 
press .

5.  Template: You can insert a text 
template saved on the phone. 
After selecting a template, press 

. The selected template is 
inserted into the Message window.

6.  Emoticon: You can insert an 
emoticon on writing a message.

7.  Name & Number: After 
searching the name and the 
number in phonebook, you can 
insert the entry.

8.  New slide: Select this to add a 
new slide.

9.  Subject: Select this to insert a 
subject.

]  Save to drafts: Select this to save 
the message to drafts.

]  Input method: Select the desired 
dictionary mode.

]  Writing language: You can select 
the language for writing a message.

]  Add to dictionary: You can add a 
word to the dictionary.

2.  Press the right soft key [Back] to 
exit the menu or go to previous 
menu after setting submenus.

3.  Press the center key [Send] to 
insert recipients address. After 
filling at least one recipient fields, 
press the confirmation key [Send] 
tosend the message. The message 
will automatically be saved in the 
Sent Items folder. If the message has 
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not been sent, it will remain in the 
Outbox with a failed status.

Email  (Menu 5.1.2)

To send/receive an Email, you should 
set up the Email account. 

1.  Enter the Email addresses of the 
recipients in the To, Cc, Bcc fields. 
You can search the Contacts by 
pressing .

Note
]  Enter the reference Email address 

to forward the Email in Cc(Carbon 
copy) field.

]  Enter a hidden reference Email 
address to forward the Email 
without forwarding information in 
Bcc(Blind Carbon Copy) field.

]  Only valid Email addresses are 
allowed for the recipient (To), 
reference address (Cc) and hidden 
reference address (BCC) fields. 
When an Email address has been 
specified, another field where 
you can specify another address 
appears. You can specify up to 
20 recipients for the To and Cc 
address fields and 10 recipients for 
the BCC address field.

2.  Move the cursor to the Subject field 
and key in the subject. 

3.  You can enter the message contents 
by moving the cursor to the Message 
field.

4.  Use the following functions by using 
the left soft key [Options].

]  Insert: Select this menu to insert 
special characters, templates, and 
contacts. It is also possible to 
attach multimedia files (pictures, 
videos and sounds).

]  Search contacts: Select this menu 
to insert Email addresses saved in 
Contacts. (Only shown in Option 
menu when cursor is located in 
To/Cc/Bcc fields.)

]  Recently used: You can use the 
latest Email address you sent.

]  Save to drafts: Select this menu 
to save the message in Drafts.

]  View attachment: Shows the 
attached files. (This item is only 
available when some files have been 
attached.)
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]  Remove: Deletes the attachment 
file. (This item is only available 
when the files are already 
attached.)

]  Input method: Select the desired 
dictionary mode.

]  Add to dictionary: You can add a 
new word to the dictionary.

]  Writing language: You can 
change the writing language.

]  Set mail priority: You can 
configure the priority of the Email 
you wish to send.

5.  When you have finished writing an 
Email, press  to send the Email.

Inbox Menu 5.2

1.  You can view received messages. 
Select a message and then press  
to view the message.

2.  You can view the previous or next 
message by using  / .

3.  To view a multimedia message 
(Notification), select Retrieve in the 
message notification view screen. 
The file is then transmitted, and 
you can view the file when the 
transmission is complete.

You can use the following functions 
by using the left soft key [Options] in 
the Inbox.

]  Reply to: Creates a reply to the 
sender or all recipients of the 
selected message.

]  Forward: Forwards the selected 
message. 

Note
Not supported for multimedia 
message (Notification) and WAP push 
messages.

]  Make voice call: You can make a 
voice call.

]  Make video call: You can make a 
video call.

]  Delete: Deletes the current 
message.

]  Create new message: You can 
write a new message or an Email.

]  Copy: In case of SMS, you can 
copy the message into handset 
or USIM.

]  Move: In case of SMS, you can 
move the message into handset 
or USIM.
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]  Filter: Displays messages by 
desired message types.

]  Mark/Unmark: You can select 
one or more messages for multiple 
deletion.

]  Message information: You can 
check the message type, date 
and time. 

Note
You can check the saved emails in 
Email [Menu 5.9.3].

Mailbox Menu 5.3

Viewing Email message list
1.  Select an Email account and then 

press  to view the received 
Email list.

2.  In Email list, you can use the 
following functions by using the left 
soft key [Options].

]  Reply: Creates a reply to the 
selected Email.

]  Forward: Forwards the selected 
Email message to others.

]  Retrieve (POP3 only): Retrieves 
new Email messages.

]  Copy to (IMAP only): Copies the 
selected email .

]  Search: Searches the Email you 
want to find out.

]  Delete: Deletes the Email.

]  Delete from server (POP3 
only): Deletes the message or 
Email from server.

]  Create new message: Creates a 
new message or Email.

]  Mark/Unmark: Use mark/unmark 
option for multiple deletion.

]  Set as read/unread: You can 
set the selected Email to read or 
unread.

]  Sort by: You can sort Email 
according to the conditions.

]  Expunge (IMAP only): Removes 
the selected Email data at a time.

]  Message synchronisation (IMAP 
only): Synchronises Email to 
retrieve Email server.

]  Message information: Brief 
information on the message 
including size, type, date, time and 
filenames.
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Viewing an Email message
1.  Select one of the received Emails and 

press the View key to receive the 
contents of the Email.

2.  The contents of the received Email 
are automatically displayed in the 
View screen.

3.  You can view the contents of the 
previous or next Email by using  
/ .

4.  In the Email View screen, you can 
select the following functions by 
using the left soft key [Options].

]  Reply to: Creates a reply to the 
selected Email. 

]  Forward: Forwards the selected 
Email message to others.

]  Save address: Saves the sender's 
address to Contacts.

]  Delete: Deletes the Email.

]  Extract: Extracts the number, 
Email address or Web address from 
Email message.

]  View attachment: Shows the 
attached file.

]  View recipients: Shows the Email 
addresses of the recipients and 
reference (Cc).

]  Create new message: Creates a 
new message.

]  Message infomation: Brief 
information on the message 
including size, type, date, time and 
filenames.

Drafts Menu 5.4

You can view saved messages. Select 
a message and then press  to edit 
the message.

You can use the following functions by 
using the left soft key [Options].

] Send: Sends the selected message.

]  Delete: Deletes the selected 
message.

]  Create new message: You can write 
a new message or an Email.

]  Mark/Unmark: You can select 
one or more messages for multiple 
deletion.

]  Filter: Displays messages by desired 
message types.
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]  Message information: You can 
check the message type, date and 
time.  

Outbox Menu 5.5

The Outbox is a temporary storage 
place for messages waiting to be sent. 
Failed messages are also placed in 
Outbox. For example, Emails will be 
placed in Outbox if the Email account is 
not correctly configured.

1. Select a message.

2.  You can use the following functions 
by using the left soft key [Options].

[For sending / waiting messages] 

]  Create new message: You can write 
a new message or an Email.

]  Cancel sending: You can stop 
sending/waiting status.

]  Message information: You can 
check the message type, date, time, 
size and where it's saved.

[For a failed message]

]  Resend: Resends the selected 
message.

]  Delete: Deletes the current message.

]  Save to drafts: You can send the 
message to drafts.

]  Create new message: You can write 
a new message or an Email.

]  Message information: You can 
check the message type, date and 
time. 

Sent items Menu 5.6

Shows the messages you sent 
(Message/Email/Postcard).

[Options]

]  Reply to: Creates a reply to sender 
or all recipients of the selected 
message.

]  Forward: Forwards the selected 
message.

]  Edit: You can edit the selected 
message.

]  Delete: Deletes the selected 
message.

]  Create new message: You can write 
a new message.
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]  Mark/Unmark: You can select 
one or more messages for multiple 
deletion.

]  Filter: Displays messages by desired 
message types.

]  Message information: You can 
check the message type, date and 
time. 

Templates Menu 5.7

Text templates   (Menu 5.7.1)

You can add, edit, and delete 
frequently used useful phrases using 
the left soft key [Options].

Note
Depending on your service provider, 
useful phrases are saved as a default.

Multimedia templates
(Menu 5.7.2)

You can create, edit and view available 
templates when creating multimedia 
messages. Five types of template 
(Birthday, Greeting, Holiday, Thanks, 
Sorry) are saved by default.

The following options are available.

]  Add new: You can create a new 
multimedia template.

]  Write multimedia message: 
Creates a multimedia message with 
the selected template.

]  Edit: Edits the selected template.

]  View attachments: You can open 
the attachment file in a message.

Emoticons  Menu 5.8

You can add, edit and delete 
emoticons. You can insert the emoticon 
which you preferred on writing a 
message. If you press confirmation key, 
you can view the icon.

Settings Menu 5.9

Text message  (Menu 5.9.1)

You can configure text message related 
options.

1.  Text message centre: Input the 
address of the Text message centre.

2.  Delivery report: By enabling this 
option, you can verify whether your 
message has been sent successfully.
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3.  Validity period: This network 
service allows you to set how long 
your text messages will be stored at 
the message centre.

4.  Message types: Text, Voice, Fax, 
X.400, Email 
Usually, the type of message is set 
to Text. You can convert your text 
into alternative formats. Contact 
your service provider for the 
availability of this function.

5.  Character encoding: Auto/ 
Default alphabet/ Unicode.

]  Auto: Message with single byte 
character is normally encoded in 
Default alphabet(GSM7). Message 
with double-byte character 
is automatically encoded in 
unicode(UCS2).

]  Default alphabet: Message 
with even double byte character 
is encoded in single byte. Please 
note that double byte characters 
with accent may be converted 
into single byte character without 
accent.

]  Unicode: Message is encoded in 
double byte. Please note that you 
may be charged double.

6.  Send long text as: Select a long 
text message as Multiple SMS or 
MMS.

Multimedia message   (Menu 5.9.2)

You can configure Multimedia message 
related options.

1.  Retrieval mode: You can set the 
retrieval mode using Home network 
and Roaming network respectively. 
If you select Automatic, you 
will receive multimedia messages 
automatically. If you select Manual, 
you will only receive a notification 
message in the inbox and then you 
can decide whether to download 
multimedia messages or not.

2.  Delivery report: Allows you to 
determine whether to request a 
delivery confirmation mail to a 
recipient, and whether to allow 
sending a delivery confirmation mail 
to a sender.

]  Request report: Determines 
whether to request a delivery 
confirmation mail for a Multimedia 
message.
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]  Allow report: Determines 
whether to allow sending a delivery 
confirmation mail for a delivery 
confirmation mail request.

3.  Read reply: Allows you to 
determine whether to request a read 
confirmation mail to a recipient, and 
whether to allow sending a read 
confirmation mail to a sender.

]  Request reply: Determines 
whether to request a read 
confirmation mail for a Multimedia 
message.

]  Allow reply: Determines 
whether to allow sending a read 
confirmation mail for a read 
confirmation mail request.

4.  Priority: You can select the priority 
level of the messages (Low, Normal 
and High).

5.  Validity period: Allows you to 
configure the term of validity for 
a message when transmitting a 
multimedia message. The message 
would be saved in the multimedia 
message server only for the 
configured term.

6.  Slide duration: Allows you to 
configure the duration of each page 
when writing a message.

7.  Delivery time: Configures the 
delivery time of message to the 
recipient. The Multimedia message 
centre will deliver the message after 
the delivery time.

8.  Multi. msg centre: Allows  you to 
configure network information such 
as the MMSC and the WAP gateway, 
to send a multimedia message.

     Using the left soft key [Options], 
you can activate, add or delete a 
profile. A profile name selected by a 
checkmark is the currently configured 
value. You can view and edit the 
contents of the profile in edit mode 
by pressing the right soft key [Edit]. 
The edit screen also appears when 
creating a new profile under Options. 
The meaning of each item is given 
below.

]  Title: Profile name.

]  MMSC URL: Enter the multimedia 
message centre URL.

]  MMS Proxy: Enter the WAP 
gateway address and port number.

]  Connection mode: Select one of 
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the connection mode. (TCP with 
Proxy, TCP without Proxy, UDP)

]  Access points: Specify the access 
point name. (see WAP connection 
settings.)

Press the center key [Save] to 
savethe changes and complete 
Multimediamsg. centre setting.

Email  (Menu 5.9.3)

You can configure settings for receiving 
and transmitting emails.

1.  Email accounts: You can create or 
configure an Email account including 
the Email server and user ID. You 
can edit a selected Email account by 
pressing the left soft key[option]- 
2.Edit. You can select an Email 
account to be used to send an 
Email using . You can select the 
following functions using the left soft 
key [Options].

]  Add: Create a new Email account.

]  Edit: To edit the selected Email 
account.

]  View: Views a selected mail.

]  Mark/Unmark: Use mark/unmark 
option for multiple deletion.

]  Delete: Deletes a selected Email 
account. All the emails included in 
the account will be deleted.

2.  Allow reply Email: Determines 
whether to allow sending a read 
confirmation mail for a read 
confirmation mail request.

3.  Request reply Email: Determines 
whether to request a read 
confirmation mail.

4.  Retrieve interval: You can 
configure Retrieve interval to retrieve 
emails automatically from the 
incoming mail server. When a new 
Email arrives, an icon appears at the 
top of the screen. You can select 
the auto receiving time slot to Off, 
15 minutes, 30 minutes, 1 hour, 2 
hours, 4 hours or 8 hours. Please 
note that additional charges may be 
incurred using the Retrieve interval 
feature.

5.  Include message in Fwd. & Reply: 
Determines whether to include the 
original message when you forward 
the message or reply to it.
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6.  Include attachment: Determines 
whether to include the attachment 
file when you forward the message.

7.  Auto retrieval in Roaming: 
Retrieves Email account 
automatically when you move in 
roaming area.

8.  New Email noti. info: Receives the 
notification information when arriving 
new Email.

9.  Signature: You can configure a text 
signature to be attached to the end 
of an Email. The configured signature 
text is automatically or manually 
attached to the end of the Email 
when it is sent.

10.  Priority: You can select the 
priority level of Emails (Low, 
Normal and High).

Creating a new Email account

1.  Select Add new from the Email 
account menu options.

2.  The following items need to be 
configured.

Title Enter a title.

Username Enter the user name of 
the Email account.

Password Enter the Email account 
password.

Email address Enter the Email address 
for outgoing mail.

Reply Email 
address

Enter the Email address to 
reply to your Email.

Outgoing mail 
server

Enter the outgoing Email 
server.

Incoming mail 
server

Enter the incoming Email 
server.

Maximum 
receive size

Select the maximum Email 
receive size using the left 
soft key. The permissible 
maximum receive size is no 
more than 1MB.

Mailbox type Select the Email inbox 
type either POP3 or 
IMAP4 using the left 
soft key.

Save to server Determine whether to 
leave a copy of messages 
on the incoming server or 
not using the left soft key. 
When the mailbox type 
is set to IMAP4, a copy 
of messages are always 
saved to the server.
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Save sent mail 
into

Select where to save 
the sent mails (when 
the mailbox type is set 
to IMAP4). When the 
mailbox type is POP3, 
sent mails are always 
saved into handset.

Access points Select an access point to 
connect to the Internet. 
You can select a confi g-
ured access point using 
the left soft key.

Auto retrieve Determine whether to 
retrieve email automati-
cally from the incoming 
mail server or not using 
the left soft key.

Advanced 
settings 

Sets the confi guration to 
connect Email server.

SMTP port 
number

Enter the mail server port 
number. In general, the 
SMTP (Outgoing mail 
server port number) is 25.

Incoming 
server port

Enter the mail server port 
number. In general, the 
incoming mail server port 
number is 110(POP3) or 
143(IMAP4).

SMTP authen-
tication

Decide whether the 
outgoing mail server to 
require authentication 
or not using the left soft 
key. When the SMTP 
authentication is set to 
On, you can enter the 
SMTP Username and 
SMTP Password for SMTP 
authentication.

SMTP user-
name

Enters SMTP user name to 
require authentifi cation.

SMTP pass-
word

Enters SMTP password to 
require authentifi cation.

APOP secure 
login

Decide whether to acti-
vate APOP secure login or 
not using the left soft key. 
When the mailbox type is 
IMAP4, APOP secure login 
is always set to OFF.

3.  Press the centre soft key [Save] 
to complete the Email account 
configuration. 

Editing an Email account

1.  Select a desired Email account from 
the Email account list and press the 
left soft [Options] then select Edit.

2.  You can edit desired fields by moving 
the cursor up and down.
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3.  When configuration is complete, 
press the centre soft key [Save] 
to complete the Email account 
configuration.

Note
When you try to change the 
mailbox type, all emails downloaded 
before would be deleted.

Videomail (Menu 5.9.4)

You can send or receive the mail with 
a video file.

Voicemail  (Menu 5.9.5)

You can send or receive the mail with 
a voice file.

Service message  (Menu 5.9.6)

You can configure the option settings 
such as Push(SI/SL) messages.

]  Service message: If you set On, all 
service messages will be received.

]  Service security: If you set Message 
received to On, you can select the 
service loading option from Prompt, 
Disable, Always.

-  Service security set: If you set 
Service loading to Prompt, you 
will see popup asking you whether 
process the SL message.

-  Trusted list: If you set Service 
loading to Disable, you cannot 
receive SL message. SL message will 
be discarded at the time of arrival.

-  untrusted list: If you set Service 
loading to Always, SL message 
is automatically launched to the 
Internet with URL that is preset in 
the SL message.

Info. service  (Menu 5.9.7)

]  Cell broadcast: You can set the 
reception status.

]  Channels: You can add or modify 
the channels.

]  Languages: You can select the 
language you want by pressing . 
Then, the info service message will be 
shown in the language that you have 
selected.
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My stuff [Menu 6]

My images Menu 6.1

The Pictures folder consists of 
embedded links for downloading 
pictures through the Internet and 
Default images.
Pictures taken using the camera are 
stored in the Pictures folder and you 
can create new folders to manage them. 
You can also send multiple files to 
other people.

To view the picture in details, press the 
confirmation key. 

When a file is selected, the following 
options will be displayed by pressing 
the left soft key [Options].

]  Send: You can send the selected 
image via Message, Email or 
Bluetooth. 

]  Use as

-  Wallpaper: You can set an image 
as the home screen theme.

-  Contacts image: You can set the 
image of selected entry in contacts. 
When incoming a call, the image 
saved in contact is displayed.

-  Start up: You can set the image 
when switching on the phone.

-  Shut down: You can set the image 
when switching off the phone.

-  Outgoing call: You can set an 
image when making a call.

]  Sort by: You can sort the files by 
date, file type or name.

]  List view/Grid view: You can view 
the images as a List view or Grid view.

]  File info.: Shows information on the 
selected image file.

]  Memory manager: You can view the 
memory status (handset or external 
memory card).

My sounds Menu 6.2

The Sounds folder consists of 
embedded links for downloading 
ringtones and music as well as folders 
containing the Default sounds and 
Voice recordings. Here you can manage, 
send or set sounds as ringtones.

When a file is selected, the following 
options will be displayed by pressing 
the left soft key [Options].

]  Send: You can send the selected 
sound via Message, Email or 
Bluetooth. 
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]  Use as

-  Voice ringtone: You can set 
the sound file as a ringtone when 
incoming a voice call.

-  Video ringtone: You can set 
the sound file as a ringtone when 
incoming a video call.

-  Message tone: You can set the 
sound file as a ringtone when 
receiving a message.

-  Start up: You can set the sound 
file as a ringtone when handset 
starts up.

-  Shut down: You can set the sound 
file as a ringtone when handset 
shut down.

]  Move: Moves the file into handset 
memory or external memory.

]  Copy: Copies the file in handset 
memory or external memory.

]  Delete: Deletes the selected video.

]  Mark/Unmark: Using the Mark 
function, you can send, delete, move 
and copy multiple files.

]  File: Shows the information on the 
selected sound file.

]  Sort by: You can sort the files by 
date, file type or name.

]  Memory manager: You can view the 
memory status (handset or external 
memory card).

My videos Menu 6.3

Here you can manage or send 
downloaded or captured videos clips.

If you press [Connect], you can 
activate the video file. 

The following are available using the left 
soft key [Options] in the Video list.

]  Send: You can send the selected 
video clip via Message, Email or 
Bluetooth if not protected by Digital 
Rights Management (DRM).

]  Use as: You can set the video file as 
voice ringtone or video ringtone.

]  Move: Moves the file into handset 
memory or external memory.

]  Copy: Copies the file in handset 
memory or external memory.

]  Delete: Deletes the selected video.

]  Mark/Unmark: Using the Mark 
function, you can send, delete, move 
and copy multiple files.

M
y stuff

My stuff
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]  File

-  Rename: You can rename the 
video.

-  File info.: Shows information on 
the selected video file.

]  Create new folder: You can create 
a new folder.

]  Sort by: You can sort files by name, 
date, or file type.

]  List view/Grid view: You can view 
the images as a List view or Grid view.

]  Memory manager: Displays the 
memory status (handset or external 
memory card).

You can view a video using the video 
player. Video files are displayed in the 
list as thumbnails. You can select a 
desired video by using the  /  
/  /  . Select a desired video and 
select Play to view the recorded video.

Select the left soft key [Send] to attach 
the selected video to a message, Email 
or Bluetooth.

When option 1. Play is selected, the 
video clip will be played with the Media 
Player. To pause the playback, press 

 during the playback. To resume the 
paused playback, press  once again.

When viewing video clips in the Media 
Player, the following options are 
available:

]  Landscape view: You can view the 
video in wide view mode.

Note
You can also view the video in 
wide view mode by pressing 

 key.

]  Mute/Unmute: If the Volume is 
set to more than 0, Mute mode is 
activated and if the Volume is set to 
0, the Unmute mode is activated. 

]  Repeat: You can set the repeat 
option (None/Current file/All files).

]  File info.: You can check information 
on files being played (File name, Size, 
Date, Type, Duration, Protection).

]  Send: You can send the video via 
Message,  Email or Bluetooth if the 
file is not protected by Digital Rights 
Management (DRM).

]  Delete: Deletes the selected video.

]  Use as: You can set the video file 
as voice ringtone or video ringtone. 
This menu is dependent upon the 
contents.

M
y stuff
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My games & apps Menu 6.4

You can easily download games and 
other applications in this menu. It 
may have two folders, no folders at 
all, or Games and Applications. The 
default folder can be dependent on 
the operator/country. Each folder has 
an embedded link for downloading 
games or applications. Please note that 
additional cost may be incurred when 
using online services. You can create a 
folder using the left soft key [Options].

Others Menu 6.5

Other files except pictures, sounds, 
videos, games & applications are stored 
in this folder. 

My memory card Menu 6.6

If you purchase an optional external 
microSD memory card, you can manage 
more content. Refer to the section 
how to use a microSD memory card 
on page 21 and 22 to learn how to 
insert and remove the memory card. 
You can manage content as you do on 
your phone.

M
y stuff

My stuff
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Google [Menu 7]
G

oogle
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Contacts [Menu 8]

Add new Menu 8.1

You can register a new contact address. 
You can enter the name, different 
phone numbers and Email addresses of 
a new contact. You can also assign the 
contact to groups, include an image or 
avatar, assign a specific ringtone and 
even enter a memo for the contact. 
Other available fields include Home 
page URL, Home address, Company 
name, Job title and company address. 
You can enter and manage contact 
addresses depending on the memory 
usage.

Search Menu 8.2

Performs the contact address search 
function. The search operation is 
performed based on a first name as 
a default. The current search method 
and results found are displayed in the 
Search window. You can make a phone 
call or send a message to the selected 
phone number. A Contacts search can 
be performed based on the phone 
number or group information.

Note
In Settings menu, the search 
operation can be performed based on 
the last name.

Speed dials Menu 8.3

Using this menu you can manage 
speed dials. Speed dials are configured 
between 2-9. You can register speed 
dials for a specific contact address up 
to 5 different numbers, and a contact 
address may have multiple speed dials.

Groups Menu 8.4

Using this menu you can manage 
group information (both stored in the 
Handset and the USIM). In the handset 
memory, there are 5 default groups: 
Family, Friends, Colleagues, School 
and VIP. You can add, edit and delete 
groups. When a ringtone for a number 
is not specified, a call from the number 
sounds the group ringtone assigned to 
the number for the group.

Contacts
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Service dial numbers
 Menu 8.5

You can view the list of Service Dialling 
Numbers (SDN) assigned by your 
service provider (if supported by the 
USIM card). Such numbers include 
emergency, directory enquiries and 
voice mail numbers. After selecting a 
service number, press  to dial the 
service. 

Own number Menu 8.6

Allows you to display your phone 
number in the USIM card. You can 
save own numbers being used in the 
USIM card.

My business card Menu 8.7

You can create your own business card 
by pressing the left soft key Add. After 
entering the name, number, Email and 
image, you can use it as a business card 
when sending the message.

Settings Menu 8.8

Display data (Menu 8.8.1)

]  View contacts from: Select which 
contact information shall be displayed 
(from handset memory, from USIM 
card or both). All is the default 
setting. 

]  Name display: You can set the 
display order by name.

]  Show picture: Select whether to 
display picture or not.

Synchonise contact (Menu 8.8.2)

You can send the contents of 
phonebook to the server directly.

Copy   (Menu 8.8.3)

You can copy contacts from the phone 
memory to the USIM or from the USIM 
to the phone memory. You can copy all 
or selected entries at a time.

Contacts
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Move (Menu 8.8.4)

You can move contacts from the phone 
memory to the USIM or from the USIM 
to the phone memory. You can move all 
or selected items at a time. 

Backup contacts (Menu 8.8.5)

You can save all phonebook data in 
handset to external memory card by 
formatting vcard. 

Restore contacts (Menu 8.8.6)

You can restore all phonebook data 
in external memory card  to phone 
memory by formatting vcard.

Clear contacts (Menu 8.8.7)

Clears all contact information. You can 
delete all contacts saved in the mobile 
phone memory as well as on the USIM 
card.

Memory info. (Menu 8.8.8)

You can check the status of contacts 
memory in this menu.

Contacts

Contacts
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Tools [Menu 9]
Tools

Quick menu Menu 9.1

You can specify functions to save in the 
Quick menu. If you save the functions 
frequently used in the Quick menu, you 
can quickly start the functions simply 
by pressing key.

Alarms Menu 9.2

If you set the alarm, the  appears 
on the indicator bar. The specified 
alarm sounds at the scheduled time. 
Press  to stop the alarm, and the 
alarm is released. Press the right soft 
key [Snooze] and choose the snooze 
interval. The alarm sound stops and 
resumes after the selected Snooze 
duration. You can configure up to 5 
alarms.

1.  Select your desired alarm to 
configure in the alarm list. If there 
is no alarm, press the left soft key 
[Add] to add a new alarm.

2.  Set/Cancel alarm: Set or cancel 
the alarm using the options for 
specifying whether the alarm is on or 
by choosing the alarm time.

3.  Input alarm time: Input your 
desired alarm time by specifying 
Hour and Minute. Choose either 
‘AM’ or ‘PM’ which is visible if 12 
hour format is specified for the 
phone.

4.  Select repeat mode: Select the 
desired repeat mode using  /  
or select the desired one from the 
list by pressing left soft key [List].

5.  Select bell: Select the bell to ring 
at the alarm time opening the list by 
pressing left soft key [Edit].

6. Input memo: Input alarm name.

7.  Snooze: You can set the snooze 
duration for the alarm.

8.  When you have finished setting the 
alarm, press the centre key [Save].

Note
The alarm will go on even when the 
phone is switched off.
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Tools

Calculator  Menu 9.3

The calculator module allows you to 
perform basic arithmetic functions such 
as addition, subtraction, multiplication, 
and division as well as some scientific 
functions. (sin, cos, tan, log, ln, exp, 
sqrt, deg, rad)

1. Press the left soft key [Options].

2. Select the appropriate function.

You can enter numbers by using the 
number keys, and the operators by 
using  /  /  / . You can 
enter a decimal point by pressing . 
Whenever you press , characters are 
sequentially deleted in reverse order. 
Whenever you hold  down, all the 
characters are deleted in reverse order 
in one go.

When calculation is complete and 
the result is displayed on the screen, 
pressing a symbol saves the result into 
the symbol, and continues calculation.

Converter  Menu 9.4

Using this menu, users can convert 
Currency, Surface, Length, Weight, 
Temperature, Volume and Velocity.

1. Select the unit menu.

2.  Users can set a exchange rate using 
option menu.

3.  Enter the current rate, and then you 
can convert from one currency to 
another.

4. You can view the value of units.

5.  Press [Reset] to clear the current 
input Field.

6.  To exit the conversion function, 
press the [Back] key.

World time  Menu 9.5

The World time function provides time 
information on major cities worldwide.

1.  You can select a desired city as 
a base using the left soft key 
[Options] - [Add city] - Press the 
left soft key [Map].

2.  You can Change the city using the 
left softkey [Options] - [Change 
city] or [Change current city].

3.  You can apply to Daylight Saving 
timeusing the left soft key [Options] 
- [Daylight saving].

4.  You can Select the Analog clock 
mode[Options] - [Analog clock].
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STK(USIM service)
 Menu 9.6

Depending on whether you have SAT 
support services or not (i.e. USIM  
Application Toolkit) on the USIM 
card, this menu (Menu #.7.3) may be 
different.

If the USIM card supports SAT services, 
this menu will be the operator-specific 
service name stored on the USIM card, 
for instance “Special”. Please refer in 
that case to the information provided 
with your USIM card for further 
information on how to use the related 
options.
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Bluetooth  Menu 0.1

Bluetooth QD ID B013211

Bluetooth connection
Your phone has built-in Bluetooth 
wireless technology which makes it 
possible for you to connect your phone 
wirelessly to other Bluetooth devices 
such as a handsfree, PC, PDA or other 
phones.

You can, for example, have a 
conversation via a cordless Bluetooth 
handsfree or browse the Internet, 
wirelessly connected via a mobile 
phone. You can also exchange, for 
example, business cards, calendar items 
and pictures.

Note
We recommend that your phone 
and the Bluetooth device you are 
communicating with be within a range 
of 10 meters. The connection may be 
improved if there are no solid objects 
between your phone and the other 
Bluetooth device.

1. Getting started

•  Menu > 7. Settings > 6. 
Connectivity > 1. Bluetooth > 1. 
Turn on/off

To use the Bluetooth function, you 
must first set Turn on.

2. Configuring Bluetooth settings

•  Menu > 7. Settings > 6. 
Connectivity > 1. Bluetooth > 4. 
Settings

-  My device visibility: Set [My 
handset’s visibility] to [Visible] so 
that other devices can detect your 
phone when they are searching for 
a Bluetooth device. If you select 
[Hidden], other devices will not be 
able to detect your phone when they 
are searching for a Bluetooth device.

-  My device name: You can name or 
rename your phone as it will appear 
on other devices. Your phone's name 
will be shown on other devices only 
when [My handset’s visibility] is set 
to [Visible].

-  Supported services: You can view 
the list of devices sich as hedsets 
and handsfree kits supported by this 
Bluetooth enabled phone.

Connectivity [Menu 0]

Connectivity
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-  My address: You can check the 
address of Bluetooth.

Note
When user uses Bluetooth Device 
in the handset, the security of the 
handset is at risk. Therefore, we 
recommend that Bluetooth visibility 
be set to Hidden after configuration 
or device pairing. For incoming files 
via Bluetooth regardless of paired 
devices, you can choose to accept or 
reject the connection, after checking 
the sender details. 

3. Search and pair new device

<Searching new device>

You can search new device as following 
menu.

•  Menu > 7. Settings > 6. 
Connectivity > 1. Bluetooth > 2. 
Search new device

<Pairing devices>

1.  To search for a Bluetooth device to 
pair, press Add new device.

2.  Screen shows Searching for 
devices. Bluetooth devices within a 
range of 10m will be found.

3.  If Bluetooth devices are found, these 
devices are listed on the screen. If no 
Bluetooth device is found, you will 
be asked if you want to search again.

4. Pairing procedure

-  Press . A window will appear on 
the screen asking you to enter your 
password.

-  After creating a password (of 1 to 
16 digits), the user of the other 
device must enter the password 
for pairing. The user of the other 
device must know the password in 
advance for authentication.

]  KU380 supports follow Bluetooth 
services

- Headset profile

- Hands-free profile

- Object push profile

- File transfer profile

- Dial-up networking profile

- Serial port profile

Option

]  Add new device: Using this menu, 
you can pair a new Bluetooth device 
with your phone.
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]  Connect

1.  If you want to open the 
connection to the selected device, 
select the Connect.

2.  If you want to close the 
connection to the selected device, 
select the Disconnect.

]  Delete: Using this menu, you can 
delete the paired Bluetooth device.

]  Delete all: Using this menu, you can 
delete all of the paired Bluetooth 
devices.

<Pairing devices>

1.  To search for a Bluetooth device to 
pair, press Add new device.

2.  Screen shows Searching for 
devices. Bluetooth devices within a 
range of 10m will be found.

3.  If Bluetooth devices are found, these 
devices are listed on the screen. If no 
Bluetooth device is found, you will 
be asked if you want to search again.

4. Pairing procedure

-  Press . A window will appear on 
the screen asking you to enter your 
password.

-  After creating a password (of 1 to 
16 digits), the user of the other 
device must enter the password 
for pairing. The user of the other 
device must know the password in 
advance for authentication.

<Deleting devices>

1.  Select a device to delete from the 
Paired devices screen.

2.  You can delete a device by pressing 
the Delete key or by selecting 
Options > Delete. To delete all 
paired devices, select Options > 
Delete All.

<Transmitting data using 
Bluetooth>

1.  To transmit data from your phone to 
another Bluetooth device, first select 
the application where the target data 
is saved. For example, to send data 
in the My Files to another device, 
select Menu > 3. My Files > 2. My 
images / 3. My sounds / 4. My 
videos/ 6. Others / 7. My memory 
card > Select data to transmit > 
Send > 3.Bluetooth
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2. Transmitting data

1)  Paired device found is displayed. 
If the desired device does not 
exist in the list, select [Refresh].

2)  Select the device to which you 
want to transmit data from the 
devices on the screen and press 

.

3)  If the other party selects [Yes] 
for [Connection request], the 
data is transmitted.

Synchronisation  Menu 0.2

If Sync service is supported by your 
network operator, this service function 
synchronizes the data in a phone and 
the data on a server such as Contacts, 
Calendar, To do, and Memo via a 
wireless network.

Connect
1.  Select the Connect item and then 

press .

2.  Connect to the server with the 
selected server profile and the 
synchronization animation is 
displayed while the synchronization 
is performed.

Logs
Select the Logs item and then press 

 to view the log for the last 
synchronization operation performed.

Server synch. centre
1.  Select the Server synch. centre item 

and then press .

2.  This menu allows you to configure 
the profile for a synchronization 
server.

]  Profile name: Input the name for 
the profile.

]  Host address: Contact your 
service provider.

]  SyncML proxy: Contact your 
service provider.

]  User name: Enter your user ID for 
synchronization server.

]  Password: Input your password.

]  Contacts: Select whether to 
synchronise Contacts or not.

]  Contact name: Input the contacts 
database name for server access.

]  Calendar: Select whether to 
synchronise Calendar or not.
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]  Calendar name: Input the 
calendar database name for server 
access.

]  To do: Select whether to 
synchronise Tasks or not.

]  To do name: Input the Tasks 
database name for server access.

]  Memo: Select whether to 
synchronise Memo or not.

]  Memo name: Input the Memo 
database name for server access.

]  Sync type: Select the 
synchronization type below.

-  Normal
The phone and the server are 
required to exchange information 
about the modified data.

-  Backup
The phone sends all the data from 
a database to the server. The 
server is expected to replace all 
data in the target database with 
the data sent by the phone. This 
means the phone overwrites all the 
data in the server database.

-  Restore
The server sends all its data from a 
database to the phone. The phone 
is expected to replace all data in 
the target database with the server 
sent by the server. This means the 
server overwrites all data in the 
phone database.

]  Access point: Select an access 
point to use for the data 
connection.

USB connection mode 
 Menu 0.3

You can activate USB connecton mode 
of your phone for serveral usages.

If you use Mass storage function like 
USB memory card, select Mass storage 
in this menu. Mass storage is available 
for only external memory card. 

If you use Data service such as PC 
suite application, select Data service in 
this menu.
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Browser
Browser [Menu ]

Home Menu .1

You can launch the web browser and 
access the homepage of the activated 
profile on Browser settings.

Enter address Menu .2

You can manually enter a URL address 
and access the associated web page. 

]  To enter a symbol, press the left soft 
key [Options] and select 1.Insert 
Symbol from Options menu.

]  To switch input mode, press the left 
soft key [Options] and select 2. Input 
method.

Bookmarks Menu .3

You can store frequently accessed 
or favourite URLs/Pages. Send, Add 
new, Edit, Mark/Unmark or Delete 
operations can be performed on 
Bookmarks. Several preconfigured 
URLs are stored as bookmarks.

Adding a new bookmark 

1.  Press the left soft key [Options] and 
select 2.Add new from Options 
menu.

2.  Enter the title and associated URL 
information.

3. Press  to save.

Connecting to a desired bookmark 

Press  to connect a desired 
bookmark.

Sending the bookmark to others 

Select Send from Options menu. You 
can send it via Message or Email. 

Deleting a bookmark

Select Delete from Options menu. 
You can delete multiple bookmarks 
using the Mark/Unmark option.

Editing a bookmark

Select Edit from Options menu. 
Edit the title and associated URL 
information. Press  to save.

Saved pages Menu .4

The phone can save the page on 
display as an offline file. Up to 20 
pages can be saved.
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History Menu .5

You can view the list of the pages 
you've already connected.

Settings Menu .6

You can change the settings for 
browser connectivity and display.

Profiles (Menu .6.1)

Select the appropriate profile by 
pressing . This will activate the 
profile to initiate the browser launch.

Appearance settings (Menu .6.2)

]  Character encoding 
Sets the browser default character set 
to one of the following: 
Automatic, English(ASCII), 
English(ISO), English(LATIN), 
Unicode(UCS2 BE), Unicode(UCS2 
LE), Unicode(UCS2 Auto), 
Unicode(UTF-16 BE), Unicode(UTF-
16 LE), Unicode(UTF-16 Auto), 
Unicode(UTF-8).

]  Scrolling control
Allows you to set the scroll speed by 
selecting the number of lines to scroll. 
Select from the menu either 1 line, 2 
lines or 3 lines. 

]  Show image
Allows you to enable or disable the 
image display during browsing.

Note
Enabling this function will delay 
displaying images until the 
completion of transmission. Disabling 
this function will prevent the 
browser from downloading images 
from the server, thus allowing faster 
transmission.

]  Java script
Select whether to turn JavaScript On 
or Off.

Cache  (Menu .6.3)

Enabling Cache allows you to store 
accessed pages to your phone. Once 
a page has been stored in the Cache it 
will greatly enhance the page loading 
speed on subsequent browsing of the 
same page.

Browser

Browser
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Cookies  (Menu .6.4)

Enabling Cookie allows you to store 
cookies sent from the server. Disabling 
this function will prevent cookies from 
being stored on your phone.

Security  (Menu .6.5)

Certificates list
Certificates can be viewed from the list.

Session clear
Secure (WTLS/TLS) session data can 
be cleared using this option. 

Reset settings  (Menu .6.6)

Select this to reset your phone to its 
default browser configuration.
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Settings [Menu #]

Profiles Menu #.1

You can select ringtone or vibration 
for an incoming call and configure the 
sound and volume of the ringtone, key 
tone, and sound effect, according to a 
profile. The profiles provided include 
[Normal], [Silent], [Vibrate only], 
[Outdoor], [Headset], [Customised 
1], [Customised 2], and [Customised 
3]. Select a profile, and press  to 
activate the profile. After pressing 
the left soft key [Options], select 
the Edit menu for the [Normal], 
[Outdoor], [Headset], [Customised 
1], [Customised 2] and [Customised 
3] profile to change the configuration. 
A different list of options is available 
for each profile that has been selected 
for editing.

]  Alert by
This option determines the incoming 
call notification mode. You can select 
from [Ring], [Vibration], [Silent], 
[Ring & vibration], [Ring after 
vibration], [Max Ring & Vibration].

]  Voice ringtone
You can select the ringtone for 
incoming voice calls.

]  Video ringtone
You can select the ringtone for 

incoming video calls.

]  Volume
Set the ringtone volume.

]  Message alert
You can set how often the phone is 
to inform you of a received message 
until it is read.

]  Message tone
You can select a file from among your 
own personal files or from the default 
files, to be played by the phone upon 
receiving a message.

]  Key tone
You can set the key tone to be 
played when pressing the keys.

]  Key tone volume
You can set the volume of the chosen 
key tone, choosing from 7 available 
levels.

]  Slide tone
Select the desired tone the phone 
will emit when you slide up/down 
the phone.

]  Confirmation tone
You can set the confirmation tone to 
be played by the phone to confirm 
actions.
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]  Start up sound
You can set the effect to be played 
when the phone is switched on.

]  Select start up sound
You can select which file will be 
played when the phone is switched 
on.

]  Shut down sound
You can set the effect to be played 
when the phone is switched off.

]  Select shut down sound
You can select which file will be 
played when the phone is switched 
off.

Phone  Menu #.2

Auto key lock  (Menu #.2.1)

If you activate this function, the keypad 
will be locked automatically after 
predefined delay time when the slide 
is closed.

Language  (Menu #.2.2)

Select the display language. You can 
select Automatic language option to 
change display language to the USIM 
card supported language.

Power save (Menu #.2.3)

When you don't use a phone, you can 
save the power activating this menu.

Handset info. (Menu #.2.4)

This functions shows the USIM card 
telephone number, model name and 
software version of the mobile phone.

Screen Menu #.3

This menu allows you to personalise the 
display options of the screens and of 
the menus entire graphic interface.

Screen theme  (Menu #.3.1)

You can set the screen theme to be 
displayed on the main screen.

Home screen
]  Wallpaper: You can select an image 

to be displayed on the main screen.

]  Homescreen usage: You can select  
using the Homescreen aggregator 
menu on the main screen.

Outgoing call
You can select the image to be 
displayed while trying to call.
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Start up 
You can select the image to be 
displayed while the phone is being 
switched on.

Shut down
You can select the image to be 
displayed while the phone is being 
switched off.

Menu style (Menu #.3.2)

You can select the desired menu style 
from Grid style and One by one style.

Font (Menu #.3.3)

You can set the font style, dialling 
font size, and dialling font colour using 

 / .

Backlight (Menu #.3.4)

You can set the backlight duration and 
the brightness on the Home screen and 
the duration on the Keypad individually.

Handset theme (Menu #.3.5)

You can set the theme of handset: 
White or Black

Greeting message (Menu #.3.6)

You can insert the message when 
switching on the phone. 

Date & Time  Menu #.4

Although the current time is 
automatically configured when the 
phone is registered to the network, 
users can configure the time and date 
directly using this menu. The time 
configured by the user is valid only 
while the phone is turned on.

Time
1.  Select the Time item from the Date 

& time list, and then press .

2.  Move to your desired field, Hour, 
Minute, or am/pm field using the 
navigation keys. (When you have 
selected 12 hour as Time format)

3.  Enter Hour, and Minutes using the 
number keys.

4.  Select the time format using  / .

5.  Scroll down to select the hour 
indicator format i.e. Off, Cuckoo 
clock or Chime bell.

6.  Press the centre soft key  to set 
the time with the specified value.
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Date
1.  Select the Date item from the Date 

& time list, and then press .

2.  Select the date format using  / .

3.  Enter Day, Month and Year using 
the number keys.

4.  Press the centre soft key  to set 
the date with the specified value.

Auto update date/time
When Auto Update is configured 
to On, the time and date are 
automatically updated according to 
the current time zone. If Confirm first 
is selected, the time and date update 
is confirmed before it is updated 
automatically.

Daylight saving
Select whether to activate the daylight 
saving function or not. You can set the 
Summer time difference of selected 
home city for 1 hour or 2 hours.

Flight mode  Menu #.5

If you activate the Flight mode, you can 
use the phone without connecting the 
3G wireless network. 3G wireless phone 
and FM radio signals from the phone or 
Bluetooth connections are prevented, 

but you can still do tasks which do not 
require the use of wireless network. 
With flight mode you cannot make any 
calls including emergency calls or use 
other features that require network 
service.

Network Menu #.6

Select Network
Select between Automatic and Manual.

]  Automatic: Automatically searches 
for the network and registers the 
handset to the network. This is 
recommended for best service and 
quality.

]  Manual: All the currently 2G(GSM) 
and 3G(UMTS) available networks 
are shown and you can select one 
of them for registration. If the 
registration of the network has failed, 
the network lists are listed again and 
you can select any other one for 
registration.

Note
When your handset lose the network 
in manual mode, the popup message 
to select the available network will be 
shown in the Idle screen.
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Network mode
You can set a type of network to 
search for when networks are searched 
in the Select network menu. 

]  Automatic: Searches all the networks 
connectable.

]  UMTS: Searches only networks 
supporting 3G. (Except for Swiss)

]  GSM 900/1800: Searches only 
networks supporting GSM 900/1800 
band.

]  GSM 1900: Searches only networks 
supporting GSM 1900 band.

Preferred lists
If the network is searching 
automatically, you can add a preferable 
network to be connected to. And the 
following options are available.

]  Add new: You can add a new 
network using the followings.

-  Search: You can select one from 
the network list stored in the 
phone.

-  Enter new network: You can 
enter the country code (MCC), 
the network code (MNC) and RAT 
to add.

]  Delete: Deletes the selected network.

]  Edit: You can modify the information 
of the selected network.

]  Move up: Moves the selected 
network upward.

]  Move down: Moves the selected 
network downward.

Access points
This menu shows the access point list. 
You can create new profiles, delete or 
edit them by using the Option Menu. 
However, you cannot delete or edit 
default configurations depending on 
country variant.

You can edit the following configuration 
tiems by pressing the left soft key 
[Option] and Edit.

Connection 
title

Access Point profi le name.

Bearer Choose the bearer 
from the list. (Default is 
UMTS.)

Authentica-
tion

Choose the authentica-
tion from the list. (Default 
is No auth)

User name Information provided by 
service provider.
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Password Information provided by 
service provider.

APN APN name to access 
network. Information 
provided by service 
provider.

]  Press confirm key to save any 
configuration changes.

Streaming
If you want to set different network 
setting to play streaming content, you 
can set different network settings.

Security  Menu #.7

PIN code request
When this is set to On, you are 
requested to enter your PIN each time 
you switch the phone on.

Note
]  Press the right soft key in the PIN 

code entry window to return to the 
previous step.

]  3 incorrect PIN code entries would 
invalidate the PIN code. And 
you have to enter the PUK (PIN 
Unblock Key) code to configure the 
PIN code again.

]  The maximum number of times you 
may enter the PUK code is 10. 
(Note: If you enter an incorrect 
PUK code 10 times, the USIM 
card will be blocked and must be 
replaced.)

]  If the PIN code request cannot 
be disabled by operator settings, 
you will not be able to choose this 
menu item.
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Handset lock
You can lock your phone. The following 
4 lock functions are available.

When switching on: Locks the 
handset whenever the handset is 
switched on.

If USIM changed: Locks the handset 
when the phone's USIM card has been 
changed.

Immediate: Locks the handset 
immediately.

None: Deactivates the lock function.

You are requested to enter the security 
code to confirm the selection.

]  To unlock the handset, you need to 
enter the security code.

Change codes
You can change the PIN, PIN2, and the 
mobile phone password.

PIN code
PIN is the abbreviation for Personal 
Identification Number, and is used to 
restrict use by an unauthorised user. 

PIN code change procedure
1.  Select ‘PIN code’ from the ‘Change 

codes' list and then press .

2.  Enter the current PIN code, and 
press .

3.  Enter the new PIN code, and press 
.

4.  Enter the new PIN code once again, 
and press .

]  If the PIN code is different from that 
of step 3, the procedure is restarted 
from step 3.

5.  When the PIN code is changed 
properly, a Changed message is 
displayed. If you enter an incorrect 
PIN code in step 2, the procedure 
is restarted from step 2, and the 
number of attempts you have left to 
enter the number decreased by 1.

6.  Press the right soft key in the PIN 
code entry window to return to the 
previous step.
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Note
Three incorrect PIN code entries in 
the PIN code entry window would 
invalidate the PIN code. In this case, 
you have to enter the PUK (PIN 
Unblock Key) code to configure 
the PIN code again. The maximum 
number of times you may enter the 
PUK code is 10. (Note: If you enter 
an incorrect PUK code10 times, the 
USIM card will be blocked and must 
be replaced.)

PIN2 code

PIN2 is the abbreviation for Personal 
Identification Number 2, and is used to 
restrict use by unauthorised users as 
with the PIN. The PIN2 code change 
procedure is the same as the one for 
the PIN code. 3 incorrect PIN2 code 
entries would invalidate the PIN2 code. 
In this case, you have to enter the 
PUK2 code in order to use the PIN2 
code again. The maximum number of 
times you may try to enter the PUK2 
code is 10, like PUK1. 10 incorrect 
PUK2 code entries would invalidate the 
PIN2 code.

Security code

The security code is used to change the 
mobile phone password. The maximum 
number of attempts to enter the 
security code is not limited as it is with 
PIN and PIN2.

Memory manager  Menu #.8

Handset common memory
This function shows the status of the 
user memory of the mobile phone. 
Since this function scans the overall file 
system for statistics, a few seconds are 
required.

Handset reserved memory
This function shows the status of the 
User reserved memory. The usual 
contents are Text msg, Contacts, 
Calendar, To do, Memo, Alarms, Call 
history, and Bookmarks. And it gives a 
clear illustration of the actual amount 
compared with the total amount for 
each item.

USIM memory
This function shows the status of the 
USIM card user memory.
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External memory
This function shows the status of 
the External card user memory. This 
function displays the In-use and free 
memory usage statistics.

Primary storage setting
You can select the storage to download 
the file: Handset memory or External 
memory.

Reset settings  Menu #.9

Select this to reset your phone to 
its default configuration. You are 
requested to enter the security code.
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Accessories

There are various accessories for your mobile phone. You can select these options 
according to your personal communication requirements.

Travel Adapter    Type: STA-P52ER

This charger allows 
you to charge the 
battery while away 
from home or your 
office. 

Standard Battery
(Type:  LGIP-430A)

Data cable/CD 
You can connect 
your phone to PC to 
exchange the data 
between them. 

Hands free ear-microphone 
and music player controller 
combo 
Stereo headset

Controller: Answer & 
End key, music player control, volume 
control, Hold button and microphone.

After connecting the headset and the 
controller, plug the end of controller 
into the headset jack on the right side 
of the phone.

Note
]  Always use genuine LG accessories.

]  Failure to do so may invalidate your 
warranty.

]   Accessories may vary in different 
regions: please check with our 
regional service company or agent 
for further information.
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General
Product name: KU380

System:  GSM900/DCS1800/PCS 
1900/WCDMA 2100

Net weight: 67.5g (Without battery)

Ambient temperatures
Max:  +55°C (Normal) / 

+45°C (Charging)

Min: -10°C

Technical data



 
 

   

 
 

 

 

  

 


